CYPHERBYTE

COMPLEX COMPUTING MADE SIMPLE

CypherBYTE Database Software

Training Manual



=

= Phone: 8367 6099

E-Mail: Solutions@cypherbyte.com.au

CYPHERBYTE Web: www.cypherbyte.com.au
COMPLEX COMPUTING MADE SIMPLE ABN: 70 081 759 967

TABLE OF CONTENTS

T ABLE OF CONTEN T S it tutuuuutuuuas s ssss s s s s s s s s s s s s s s s s s 6o s s 6o s s 86 s s 8888 88 8888888888888 8 RESSSRRRE SRR NSRS 2
DIS CLAIMER .oiiiuuccuiaeesunssssnnsssssnssssssnnsssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnssssannnssnnnns 4
WINDOWS B A SIS .uuituuuueuuuunssnnsnsssnssssssnnsssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnsnsssnnnnes 4
MOUSE TERMINOLOGY &t 1t uuuasateeeeessssssnnssnnnssseeeeeessesesssssssneeeessssesssssssssseseneeessssressssssnassneeeeesseesssssnsssenererrrrrens 4

8 I = N 7 =F 4
AT T £ 4
MOVE, S1ZE, CLOSE, MINIMISE, MAXIMISE AND RESTORE 11 .uutttttiustessrunneesansesssnnneessnnnesssanseressnsessssseessssnnessrnneerens 5
THE TASKBAR 1t ttttttttttttesansaseeeeesesssssasasasasseeeesssssenssssnssseneeessssssssnnsssassseeeeesssssesssssnsneeeeesssssssssssnnnnsnnnnnes 5
SHUTTING THE COMPUTER DOWN 41t uttetusseessunseessnnnnesesnneessassnesessssnsmssseesesmeemmnnnememseesrmianeremserernermnennnn. 5
VVINDOWS EXPLORER 41 utttttusaeessnnseessnnnessnnseessannnesssansessnnessssssessssnnnessssseessensnesessssesresnnesssstesssssneesssnsnerrnnnns 6
Y= )Y e Y= 1 = 6
70 VY ] e S 7
Expanding and CollapSing FOIAEIS ....... .. e ettt 7
JR=Tolo e g K3 5T I Lol o IS 7

Y= =Tt o I 7
SEIECEING MUILIDIE FIIES ... ..o ettt ettt ettt sttt ettt naa e n e eneaeas 8
Copying, Moving and Creating SROIECULS.........oue ittt ettt ettt a ettt ts e e et tataataaseananeannas 8
DEIELING FilES OF FOIUEIS. ... e ettt ettt e ettt a e ettt r e nanen e enaneas 9
Creating @ NEW FOIUEI ...... et ettt ettt et et ettt ettt e et et st ea ettt sttt s aasaaasaanaeans 9
INTRODU CTION i uuuume s s s s s s s s s s s s s s s s s s s s 6o s s 6o s s 88888 888888888 888888 88888888 8008888 REESRSRER RSB BRE 10
RAMIFICATIONS OF LOSING YOUR CYPHERBYTE DATA SERVER 1ttttuuutettrunntereinneesrnnneessanneesrainnesssnsessssnesrssnsesrrnnnnes 10
BACKING UP YOUR CYPHERBYTE DATA SERVER . .utttttuuuteetiunneetensersransmeremnseesransnesemnmesmmnnmemmmmeemmnmenen. 10
I 7 Y 0 - N 0 R 10
STAND-ALONE SETUP INSTRUCTIONS 4t tuuuttetsuuseessannnesssuneessasnnesssnsessennnessssseesessnnessssseesresnnessrsneerernneesrsrnerrns 10
NETWORK SETUP INSTRUCTIONS 41t uuuseeetsunsesssnnnnerenseesrnsnesesnsenssansessesnessmnnnesesnmessmnnanemmmnseesmmtnermrenrnnn 11

Y =T 7= gl Y =11 o P 11

L T O 1] oL Y =] A7 o 11

Y0 X [ 1=l L O L= g LY =1 (¥ o B PP 11
CHANGING YOUR CYPHERBYTE DATA SERVER LOCATION ..ccucccitirucsrmmsssssmmsnsssssssssssnsnssssssnssssnnnsnsnnnnns 11
LOGGING INTO CYPHERBYTE SOFTWARE .....ccctttiiins s unss s snssss s ssnssssssssasssssansssssssnnssnsnnnnnnnn 13
USERNAME AND PASSWORD 4 tttttuuutttssunneessnseessanseesssnssesssssnessssessssneesessseesssnneesesteesretnnereesneesrersnrrrrnneerrrnnns 13
CHANGING YOUR PASSWORD 4t s tttuuutesssunneessnseessansnesessssnesensseesmnsesmmsnsmesemnsememmamememneremmrmememmtremneirrnns 13
BYPASSING/ RE-ESTABLISHING LOGIN .11t uutttusttenaesnessnnerasessesenesensssansssanssnesrssernsermnesennssanesrnnerssersneeenerernrrnnerns 14
REGISTRATION, MODES AND UPGRADE PROTECTION ...cciicctramtramtmsnsmsasmsasmsassssnsssssssasssnnsssnssnnnssnnnnnnns 15
0 =30 T T {0 15
EXPIRED MODE 4tuuuuttttiuneeesenseessanaeessanseessannnessaassssasnnesssansesssannessesnsessssssnesssnsnesssnsnesssnsessssnnessesnsesssnnnnes 15
T £ == 5 1 [0 ) = 15
REGISTRATION 4ttt tuuuteesunneessnseessnneessanssessassnesssssessssnnessssnsessssnsnesesssessssssnesssaneessensnesssnsessssnnessssnseesssnnnes 16

L0 2] Y 0 = 16
MAINTENANCE AND SUPPORT t 11t utttttusaeesansesssanseessssseessannnesssssserssneessesntessssnneesessessrsnneremtseesrotneresrnesrrrrnnes 17
UNDERSTANDING USERS AND USER LEVELS .. cccuicittiunsunssssmnasssnsnsssssssssssnsnssssssassssssnsssssssnnssnnnnnnnnnn 18
L T2 0 £ £ = 18

N ORMAL USERS 41t tuuttttvuteeesssseessanaeessanseessansnessaassssasnnessensessssnneesssssessssnsnesssnneessensnesesnsessssnnessesnsessssnnnes 18
L] =12 I 18
Micresoft Page 2 of 30 ©2004 - 2007 CypherBYTE
CERTIFIED ABN: 70 081 759 967

Professional



=

= Phone: 8367 6099

E-Mail: Solutions@cypherbyte.com.au

CYPHERBYTE Web: www.cypherbyte.com.au
COMPLEX COMPUTING MADE SIMPLE ABN: 70 081 759 967
CYPHERBYTE SOFTWARE FEATURES....oucctiuettussissisnsssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnsssnsssnnsnn 19
UNDERSTANDING RECORDS AND FIELD S 1. ttiiiiittttttteeststeseaasaeeeeeessresaeaansnteeeeesesssesesssnnnsseeeeressseresssnnnnnnnnnes 19
N AV LG ATING THE AT A 1 tttiiiittt ittt ettt et s e sttt s e e e s e aa e e st aaaa e et aas e e s sann e e s saaaeessanaeessanseessannessannsesssnnnness 19
AUTOMATIC SAVING 4ttt tuuuteesnnneesennenesannnessssnnneresseeseneerenssmesetssneemenmeremnnenemmrmeem et rnerarnnes 20
I T I 7 20
THE PENCIL INDICATOR 1t ttaateteteeesssssessannassseseeesssssessssnssseeeeesssessessssnssseeeeessssreresssssnsnneeeeesrsesssssnnnsnnnnnns 20
RECORD LOCKED INDICATION t1uutttttusaesssansesssnnnnessnnseesssnsnessssssssssnnessesnsesssssneesssnsessssnnnessssseesrossneresssessrsnees 20
E DI TING RECORD S .t tttt i iuttteteateessnaeeseanseessananessaaseesraaeessennsesssssssesesasesssssnesssnsesssesanssssssessesnnessesnsesssnnnnes 21
LR CTe [ =Te B o X O [Tl o | [ S 21
SELECTING ONE RECORD 4tttuttttisitttessauntesssseessansessassesssnssssassesssannnessssseessennesssssnessesnnessssnsnerssnnessssnnerrnns 21
SELECTING MULTIPLE RECORD S .ttt uuttttttuustessaseessnsnesernssnerennsessmnesmmnasmemeiseemmmamememnmmemmrmemmmrinrrnns 21
DELETING RECORDS 1 ttttttuttttsssteessnneessanseessansnessasssessannesssnsessssnneesesnsessssnnnesesnseessennnessssssssssnnessesnsessssnnnes 22
REIGEIONAI RESEIICEIONS vttt ettt ettt ettt e et a et s st e e et s et e et a et s st s et s st a s st s tsa et s assaesasaanes 22
FINDING RECORDS & utttttiutetessnseessnneessanseessansnesssassessannesssnsessssnneesesssessssnnnesessneessennnesssssessssnnessesnsessrsnnnes 23
Yo 2 [gle I Y =Tl e K 23

Yo )VZ= T Tol=Te B o 1 Lo | Te RN 23
KEYBOARD SHORTCUTS 41 uutttttsunsesssunneessnseessnsnessssssessassnssssnsessssnnessssssesssssnnesesnsessssnnnesssssnesronnesresnsessrsnnnes 24
USER M ANAGEMENT 4ttt ttttuusunnsnseeeeesssssesesssnasseeeesessrsrassssnsseeeeessssresssssssasnneneeessreressssssnsneeesssreessssssnnsnnnnnns 25
Managing USEernames And PaASSWOITS. . ... esasseiae ettt et a s ettt e ettt e s asese st tae st ssaaanaasasrnaneannas 25
RESELLING USEI PASSWOITS ...ttt ettt ettt e st et st a et e rran e aanenenananeas 25
Managing ACCESS RIGAES......ueiiie ittt et ettt ettt et ettt ettt et et e et e e st et ettt atanaasaananeaanas 25
Y = a0 U o= 3 25
(02T gy Lo [ Te I = | N 25
SENDING US FEEDBACK 11ttt tutttessuseessnneessnassessannnesssnsessesneesesssessssnsnesesseessesnnessssnnesresneesrsteerrssnnerersrnerrrns 25
CREATING BASIC QUERIES ...ciucuciucerumerasmarsssssssrssss s sssnsssssssssssssssssssnsss s ss snsss s ssssnsssssssssssssnsansnsnssnsns 26
QUERY DIESIGN t1uutiutstuessseessnessesassssnssanessanssanesasesanesssnssnsssnesssnessessnesssnsssnesssnsssnemsnessnesennsesnsesnessnnernns 27
Yo [ 1g T = I o =1 L S 27
R =lanlodY [ale I I (=] Lo AP 27

L £ LT 0 1 1 = 28
F0 = 7= I 7 2= 28

(O g1 a=T g 1= = g 0] =11 [0 g 1= P 28
102 O 1 1 =] = I 28
WYY O 1] o - I 28

L g ol (i) Oy 1= o - 29
RS0 11 T 07 N 30
CREATING CALCULATED FIELD S 4 tttuttttttuuttessiuttessanneesssaneessansesssnssssnneessssseessssnnesssneessessnessssnnesresnnsessssnerenns 30
EXPIESSION RUIES. ... ettt ettt ettt et ettt s ettt 30
MORE QUERIES AND REPORTS .uuuuttuusetusesnsessnnssnessnnesnessssssssssessnsssnesssnemsnessnesennsssnesenesssnersnemsneesnmennssnnesns 30
Micresoft Page 3 of 30 ©2004 - 2007 CypherBYTE
CERTIFIED ABN: 70 081 759 967

Professional



=

= Phone: 8367 6099

E-Mail: Solutions@cypherbyte.com.au

CYPHERBYTE Web: www.cypherbyte.com.au

COMPLEX COMPUTING MADE SIMPLE ABN: 70 081 759 967
Disclaimer

We endeavour to ensure the accuracy and currency of the information described in this manual, however,
CypherBYTE refines the software produced and therefore we cannot guarantee precise accuracy of this
information. CypherBYTE disclaims all liability for any direct, indirect, incidental, or consequential, special or
exemplary damages resulting from the use of the information in this document or from the use of any products
described in this document. Data used in examples and sample data files are intended to be fictional. Any
resemblance to real persons or companies is entirely coincidental.

Windows Basics

This information is provided primarily for reference sake. Setting up CypherBYTE software can involve some
basic file management skills, which can be learned here.

Mouse Terminology

Point Use the mouse pointer to point to an object, do not click.

Click Press the left mouse button once then release.

Double Click Press the left mouse button twice without moving the mouse between clicks.
If you do it too slow you will get two clicks.

Drag Hold the left mouse button down and move the mouse.

Right Click Press the right mouse button down once then release.

Right-Drag Press the right mouse button down and then move the mouse.

File Names

Windows supports long file names. You can have up to 255 characters for both folder and file names. These
file names can include most characters including spaces. Some invalid characters are: \ * ? /

Windows
A window is a rectangle that holds an application or a document. There are three kinds of windows:

o Application Window
holds a Windows application or a program designed for Windows, for example Microsoft® Word™ or your
database application software designed for you by CypherBYTE.

« Document Window
holds data for an Application Window - for example your document in Microsoft® Word™.

- DOS Window or Non-Windows Application Window
holds a DOS application or a program not designed for Windows. Mainframe applications and any
applications designed prior to 1994 would run in this kind of window.
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Move, Size, Close, Minimise, Maximise and Restore
Almost every window can be moved, sized. minimised, maximised, restored or closed;

Minimise
hides the window but it remains open

Move

by dragging title bar

( this only works with a fully restorad window
- not maximised and not minimised )

Maximise
makes the window consume as much visible area as possible

I Untitled - Notepad

File Edit Format Wiew Help "
3 Close
closes the window (don't forget to saval)

Restore
Rastors raversas tha sffact of both maximise and minimisa, To "un-maximisa®,
you restors, not minimise. Same for minimise, but most people just dick the

taskbar button to restore aftar a minimise, but it is still called restoring the
window!

Size

by dragging the size arrow when

you are pointing at a window's adge

( this only works with a fully restored window
- not maximised and not minimised )

The Taskbar
;ﬁsmn| Blwineost | @Expmring-Acce...||'[gy’Micmsuﬁwgr... T Notes - Al | D™ z14pm

The Taskbar can look very different, but when you install Windows you will see the Taskbar similar to the one
pictured above. The programs listed may vary or not even be there, but the identifying feature of the Taskbar
is the Start button at the very left, which is used to start programs.

Shutting the computer down

At the end of the day, or when things go wrong, you may need to shut down the system (or restart your
computer). Just switching off the computer is NOT a good idea.

When you are running Windows, there are several files open. If you just turn it off you may cause the files to
become damaged. To correctly shut down you computer, click the start button and choose Shut Down or
Turn off Computer. From there you can;

. Shut down / Turn Off. This is what you do at the end of the day. On most systems you can do
this quickly by just pressing your power button once.

. Restart. This is what you do when you have major problems that require the computer be
restarted.
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Windows Explorer

The Windows Explorer is a flexible way to manage your computer. You can manage most of your computer
system from the Explorer. File management is the emphasis in these notes.

To start Windows Explorer, press ;'}' -E.

B Exploring - Msoffice - 51X
File Edit “iew Toolz Help
Ia M zoffice j aEIX é{:‘llal il xll o
|AII Folders | Contents of 'Msoffice’
@ Desktop & || Mame | Size | Tupe | Modified -
=& My Computer | Excel File: Folder 2408495 4:43
(-3 3% Floppy (4] | Pawerprt File Folder 2/08/95 4:42
(- 5% Floppy [B] 23 Setup File: Folder 2/08/95 4:43
&&= Clarke 486c (C] 23 winword File Folder 2/08/95 4:43
~( Das Chklist.ms 1KB M5 Fils 28/07/95 516
::g Efghange | Club.brap 1KE  Bitmap Image 7/02/94 12:00
B3 Hpoiet Q Mharmond. bmp 1kE  Bitmap Image FAO02/34 712400
G Isw @ Heart. brmp 1KB  Bitmap Image TA02/534 1200
{23 Mouse @ Mrm.brp BSKE  Bitmap Image 2303495 321
(23 Msmoney @‘Mm‘l.bmp B3KE  Bitmap Image 24/03/951:39
- gl M soffcue. hip 13EKE  Help File 7/02/3412:00
f - M soffice.exe 187KE  Application TA02/534 1200
F-0 Private Mzoffice.gid BKE  GID File 40895 219
-Z1 Program Files M zoffice.hip 233KE  Help File 7/02/94 1200
@ Recycled b zoffwel hip 11KE  Help File FAO02/34 712400
{23 Scan Ofreadme.hlp 1EKE  Help File 7024941200
- Setupwds Ohelp.dl OB Application Extenzion  7/02/34 1200
{0 Smartpic Pssinfo. hip 2KB  Help File 7/02/341200
gl Staff Srriley. brnp KB  Bitmap Image 7/02/94 12:00
{1 Wep ~ | |#* 5pade.bmp KB Bitmap Image 7/02/94 12:00 _I;I
“| | & “| | 3
|20 obiect(z] |753KE [Disk free space: 287ME]

WARNING: YOU CAN DAMAGE THE SOFTWARE PROGRAMS AND/OR WINDOWS WITH RECKLESS OPERATION OF
WINDOWS EXPLORER. BE VERY CAREFUL WHAT YOU DO HERE.

Staying Safe

If you are new to all this, there are a few tips to remember to avoid disaster;

¢ DO NOT DRAG!!! Dragging moves objects. One accidental drag and drop and all of a sudden you
could have moved critical files. Where to? Wherever you dropped them. This is the number one
mistake made in Windows Explorer — many dislike it for this reason alone. Remember to click cleanly
and pay careful attention to not moving the mouse during a click.

e Avoid the DELETE command and Edit - Cut. The DEL key and other delete commands delete the
selected objects. That can’t be good unless you really want to delete something. Deleting can be
permanent.

¢ Moving and Renaming can be DESTRUCTIVE. There are many files on your computer that must
remain precisely where they are. Moving or Renaming your Windows folder is a fatal mistake. To
correctly move a program, it’s data needs to be backed up, the program uninstalled, and then
reinstalled into a different location.

e Avoid OPEN commands with selections. If you have 100 objects selected and you issue an open
command (like pressing Enter or selecting File — Open) then all of the objects will be attempted to be
opened in whatever application each object is associated with. Last time I saw it happen, the machine
crashed before all the objects could be opened.
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Browsing

The left hand side of the Explorer is a list of Folders. Each folder has files and possibly other folders inside.
The right hand side of the Explorer window shows the contents of the highlighted folder.
To see the contents of a particular folder, click that folder (on the icon).

Expanding and Collapsing Folders GLEKTHE

If you want to open up a folder to show all of the folders inside that folder, a Mausze

click the PLUS SIGN icon. When you click this icon, all of the folders inside :

the associated folder will appear underneath (and indented) the folder. Try it. Once you do that, the plus sign
(+) turns into a minus sign (-) which, when clicked, will hide those folders again. You can not damage anything
by clicking the plus and minus signs to browse around.

Recognising Icons

There are many different types of icons. Understanding what they are is a matter of recognising the pictures
they represent or their extension. The icons can be small or large. Here are a couple of icons and their
meanings:

Icon Meaning Extension

Folder. This is a Directory or Folder. Both are the same. | N/A

Help file. Opening this icon will give you help on .HLP
something.

Word document. Opening this icon will result in Microsoft | .DOC
Word being opened, with the data that is in this

)|[E) @)

document.
s Excel spreadsheet. Opening this icon will result in XLS or
3' Microsoft Excel being opened, with the data that is in XLW
this file.
Selecting

Selecting Files or Folders is a necessary part of file management. If you want to delete 27 specific files, you
could either do them one by one (27 times) or you could select the 27 files and then delete them all in one
command.

Selecting files or folders is much easier than it used to be. To select single items, just click them.
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Selecting Multiple Files
There are several methods of selecting files.

Best For Action Comments

All files from here to | Click the first file, then hold Don’t press ENTER when you go for SHIFT.

here down the SHIFT key and click
the last file.

Ad-Hoc Selection Click the first file, then hold | Again be careful while CTRL-clicking. A
down the CTRL key and click | slight drag and all of a sudden you have
any other file to include or CTRL-DRAG. This means COPY. You can
exclude. end up with lots of copies if you are not

careful.

All Files Press CTRL - A. CTRL A is a command that means “Select
ALL” to most Microsoft® applications. It is
as safe as houses!

A rectangle of Drag your mouse from point Anything between the two points will be

objects to point selected. This is dangerous because you
are using drag. If you miss, you could end
up moving objects or even running them.

Remember that you can always employ any combination of the above. For example you could select all files
with CTRL-A and then use CTRL-Click to turn off the ones you don’t want.

Once selected, files can be deleted, copied, moved or opened. Renaming a file or folder cannot be done on a
multiple selection.

Copying, Moving and Creating Shortcuts

To copy a file or a folder is quite easy and there are three main methods; all of which start by selecting the
objects to copy. Once they are selected;

Copy & Paste Method. Select a COPY command (or a CUT command if you intend to MOVE the objects).
Then you select your destination folder (where you want them to go) and then you select a PASTE command.
Two COPY commands are CTRL - C and Edit - Copy. Two PASTE commands are CTRL - V and Edit - Paste.
Two CUT commands are CTRL - X and Edit - Cut.

Right Drag and Drop Method. A safe version of dragging is right-dragging. In windows explorer, right-
dragging does the same thing as drag and drop but with a safety net - at the end a popup menu appears
asking you whether you want to MOVE, COPY, CREATE SHORTCUTS or CANCEL! This is great because if you
accidentally drop to the wrong place (which happens all too often), you can cancel before it’s too late! Notice
this is the only easy way to create a shortcut to an object.

Drag and Drop Method. This is dangerous. I do not promote this method, however, you can drag the
selected files onto the destination. The files will MOVE to the destination unless the destination is a different
drive from the source files, in which case a COPY is made. If you want to COPY the files anyway then CTRL-
DRAG them to the destination. For a safe version of this see above (right drag).
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Deleting Files or Folders

Deleting is a necessary part of computing. It is also one of the most dangerous. Accidental deletion of a file
can result in effects as disastrous as disabling your computer system. When you need to delete a file or folder,
you can do so by selecting the objects to delete and then pressing the DEL key on the keyboard. There are
other ways, but this is the most universally accepted method of deleting anything.

Creating a New Folder
You may want to set up your own folder structure. To do so, you will need to be able to add folders to another.

To add a folder, follow these steps:
e Select the folder (or top level drive entry) to place the new folder into.
e Click the File menu then New then Folder. Notice that the folder already exists, it is just called
‘New Folder’, and we are simply renaming it now.
e Type the name for the new folder.
e Press ENTER.

These are just some basic Windows functions, if you would like to learn more about Windows
operations please ask your trainer about our Windows course or contact us here at CypherBYTE.
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Introduction

The following information is designed to introduce you to your custom database software application you have
had made by CypherBYTE. By now you would have received your application which is made up of at least two
files. One is your custom database system (application) and the other is the data for that system (CypherBYTE
Data Server). Your application is called something like ProjectName.mde. The data file which holds all the
data you see within your custom software is called CypherBYTEDataServer.mdb. The application or system
file is always protected — no-one except CypherBYTE can read or make changes to the design of it. The
CypherBYTE Data Server file is always unprotected, allowing you to make custom ad-hoc queries and reports
from your data.

Ramifications of Losing Your CypherBYTE Data Server

If you lose your CypherBYTE Data Server you will lose all data in every CypherBYTE application that is using
that CypherBYTE Data Server. If you are networking your CypherBYTE Data Server, this could mean that
everyone loses everything in all CypherBYTE applications. Make sure you don’t accidentally delete it, and
back it up regularly and reliably!

Backing Up Your CypherBYTE Data Server

To backup the data within your CypherBYTE application (and any other CypherBYTE applications), you only
need to include your CypherBYTEDataServer.mdb file in your regular backups. You should backup this file
every day that your software is used. If you require assistance with backing up your data, contact your
systems administrator or contact us at CypherBYTE.

Installation

Installation of your application is really quite easy if you are used to manipulating files and folders. If you need
to set it up on a network you will need to know how to share folders and map network drives. If you need help,
contact your systems administrator or you can contact us at CypherBYTE. Your first installation is normally
done for you by a CypherBYTE representative.

Assuming you have Microsoft® Access™ installed correctly on your computer, you can install the software by
simply copying the two files (the application file and the CypherBYTE Data Server) into the desired locations.

Stand-Alone Setup Instructions
If you only want to use the software on one computer follow these steps.

e Create a folder for the application (referred to as your application folder). We recommend
C:\Program Files\CypherBYTE\ <YourProjectName> as the application folder.

e Create a folder for the data (referred to as your CDS folder). The application folder and the CDS folder
can be the same if you like. We recommend My Documents\CDS as the CDS folder.

Copy the application file (normally <YourProjectName>.mde) into your application folder.

e You might like to create a shortcut to your application file while you are looking at it. To do that simply
right-drag the application file from the application folder to wherever you want your shortcut to be.
When you let go, choose Create Shortcuts Here.

Copy the CypherBYTE Data Server.mdb file into your CDS folder.

e Run (open) the application file from the Application folder, perhaps by the shortcut in order to test it.

e The application will ask for the location of the CypherBYTE Data Server. Set the server path to your
CDS folder and click OK.

e All done! You should be at the login screen.
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Network Setup Instructions
If you want multiple users to use the software, follow these steps.

Server Setup

e Create a folder on your server for the CypherBYTE Data Server (referred to as your CDS folder).
e Copy both files which make up your software into your CDS folder.
e Share your CDS folder across the users you want to be able to access the software.

First Client Setup

e Map a persistent network drive (eg X:) back to the shared CDS folder on the server.
Run the application file from the mapped drive (eg X:).
Set the server path to the mapped network drive (eg X:) and click OK. This will modify the application
file so that it knows where the CypherBYTEDataServer.mdb file is.

e Create a folder for the application file on drive C: (eg C:\Program Files\CypherBYTE\AppName).
This is referred to as the application folder.
Copy the application file from the mapped network drive (eg X:) into the application folder.
Create a shortcut to the application file in the mapped network drive (eg X:) and configure the shortcut
to have the name you want and the icon you want.

e Copy the shortcut to the desktop.

Subsequent Client Setup

e Map the same persistent network drive (eg X:) back to the shared CDS folder on the server.

e Create a folder for the application file on drive C: (eg C:\Program Files\CypherBYTE\AppName)
This is referred to as the application folder.

e Copy the application file from the mapped network drive (eg X:) into the application folder.
IF the application folder is the same on the first client machine, copy the shortcut from the mapped
network drive (eg X:) onto the desktop.

NOTE: The setup of subsequent client machines is hormally automated with batch files during Windows
startup. If you would like help in configuring your system to do automatic installation and upgrades of your
software, simply contact us at CypherBYTE.

Note that the application file resides on the local hard drive for each client. This is done for best performance
and stability.

Changing Your CypherBYTE Data Server Location

If you move or rename your CypherBYTE Data Server to another location, CypherBYTE Software will detect
that the CypherBYTE Data Server is no longer where it was, and will provide a dialog box for you to locate it.
This will happen the next time you start your CypherBYTE Software.
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Version 5.0.3 You can force the issue by pressing

Version 5.0.3 F6 (F8 for older applications) at the

_ startup screen shown at the right.
Copyright (c) Fuly 2002 CypherBYTE
This product was designed by. .. You will be given the opportunity to
select a new path for your
CypherBYTE Data Server, even

ABN: 70 081 759 967 while the current one is valid.

GILLES PLAINS &4 50386
Phone: 08 8367 6099

web: wu.cysherbyte.comas | This can be great if you want or
CWPHEREVTE email: ContactCRF@cypherbyte,com.au need to be agble to ‘sywap servers'.
Systems Administration Software Design One example where you might want

to do this is for training — you don't

another location (a training folder
perhaps) and then switch between

s Troubleshooting Bk wehsite Development want trainees working with live

B Repairs & Upgrades Bk Microsoft Excel Spreadsheet Solutions data. In this case, you could copy

& networking & Internet Connection By Microsoft Access Databases your CypherBYTE Data Server to
By

E anti-virus & Backup Strategies

Customnised Applications

Microsoft: | the live data and the training data
CERTIFIED | as necessary. Using the same idea,
Prass FE to change server [ocation, Atempting to connect to CypherBYTE Data Server.i. Professional you could create another one jUSt
A typical startup screen for practice.
Select Server Path When you have selected a drive and folder that contains a
Select Server Path | CypherBYTEDataServer.mdb file, the OK button will be
Trace your way to the folder where CypherBYTEDataServer.mdb resides, P
;Fh‘z word "Found” will appear next to the OK button when waou have a walid VISIble.
Drive: o hd 3 .
Folders: [ WolED - Click the OK button when you have the correct folder
[ selected. The next thing you should see is a message
Rarspesk stating that the CypherBYTE Data Server was successfully
i Fles connected. After clicking OK to that message, you will be at
el .
WiHDOWS the Iogln screen.
Selecting a server path (not yet found)
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Logging into CypherBYTE Software

Username and Password

When you first start CypherBYTE Software, you are

asked for a username and password combination. CypherBYTE Follower is a secured system, please enter your
username and password to log in,

The Admin User is the first in the list of usernames,

and is special in that it will provide access to areas of Username: | ~l

CypherBYTE Software that the other users may not get Password: |

access to, such as the User Management screen.

Enter your username and password to login,

You can type in "AD” into the Username box and that should be enough to select the Admin user. By default,
CypherBYTE Software has at least one username - Admin. The password for Admin is set to "admin” by
default. When you select the Admin username, the password “admin” is automatically entered for you. You
should change your password immediately if you want to establish any level of security.

CypherBYTE Follower ] In order to maintain security around the Admin
— User, you should change the password to
Waou must change wour administration password immediately ta maintain security, something Only your tOp level Administrators

should know.

Anyone who knows the password for Admin can log
in as the Admin User. The Admin User can do
anything.

Changing Your Password
To change your password,

e Select o Qptions.., from the Tools Menu

The thange my Password... | hytton allows you to change your login password. This is like any other password
changing system.

Change my Password... When you click the thange my Password... ‘ button you will see
the fields pictured left.

Qld Password: ||

To change your password, enter your old (existing) password
into the Old Password box, and enter your new password
into both the New Password and Confirm Password boxes

oK I and then click OK. If you entered the same new password
into both boxes and your password is at least 3 characters
long, your password will be changed.

Mew Password: |

Confirm Passward: |

Cancel

The Admin user can also change anyone’s password via the User Management screen. If you have forgotten
your password, you must contact your administrator. If you are the administrator and you have lost your
admin password for your software, you will need to contact CypherBYTE.
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Bypassing/Re-establishing Login

If you have no need for logins or security in your software, you can bypass the login screen. When bypassed,
the Admin user is automatically logged into the software (regardless of the password) and you will not see the
login screen. There will be no Log Out button available on the main menu when the login has been bypassed.

To bypass or re-establish the login screen and security,

e Login as the Admin user.
e Select ®w gptions,.. from the Tools Menu.

Select the 3 - Application Settings ltab

Check or clear the [ Login automatically with Admin user, bypassing secuity. checkbox to alter the setting
Click o |

Micresoft Page 14 of 30 ©2004 - 2007 CypherBYTE

CERTIFIED ABN: 70 081 759 967

Professional



= Phone: 8367 6099
E-Mail: Solutions@cypherbyte.com.au

CYPHERBYTE Web: www.cypherbyte.com.au
COMPLEX COMPUTING MADE SIMPLE ABN: 70 081 759 967

Registration, Modes and Upgrade Protection

When you first run CypherBYTE Software, you will find that the software runs in demo mode. Before we
proceed, I want to clarify the modes for you.

Demo Mode

This mode is the default mode. In this mode, you can fully utilise all the features of your CypherBYTE Software
for a limited time. At the time of writing this manual, that time is limited to around 60 days. After that time
the software runs in Expired Mode unless it is registered or unlocked.

Expired Mode

This mode only occurs when your software has not been unlocked and the demo period has expired. In this
mode, you are severely limited in what you can do.

You may never experience this mode and CypherBYTE sincerely hopes that you do not!

Registered Mode

In this mode, there are no restrictions. The only way to get CypherBYTE Software into this mode is to unlock
your software by calling CypherBYTE for an unlock code. CypherBYTE will check your status and provide an
unlock code if you have fully paid for your software. You must be in front of your computer when you call for
an unlock code. CypherBYTE does not charge for unlock codes and never intends to. This is simply our way of
protecting our software from piracy and non-paying customers.

The mode you are in is displayed underneath the main title in the menu screen. If you are running in DEMO
mode, the expiry date is also displayed.

Main Menu

CypherBYTE Follower

(REGISTERED])

‘Project Management...:

Client Managment...

User Management...

Reports...

% L Log Qut..,

CYPHERBYTE
Exit System

Liser Lavelr 10 Admin UzerIli 1

Your user level and username are also displayed in the menu screen. These are located at the bottom of the
screen. Your User ID is also displayed. The User ID is simply a unique number that identifies each user.
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Registration

Registration is a process of informing CypherBYTE of your details and paying for the software. Under normal
conditions, registration may be automatically done for you by CypherBYTE.

Once you have registered and paid for your software, you can call CypherBYTE on (08) 8367 6099 to unlock
your software. Only the registered individual can unlock the software. The security of CypherBYTE software
revolves around the unlock code, and it is there to defend against software piracy — or at least make it more
difficult.

Once you are ready to unlock your software, start your CypherBYTE software and go to Tools — Options.

CypherBY TE Follower - Yersion 5.0.3
Options

1 - Security and Licencing ]g - Personal Details l 3 - Application Settings]

Current DEMO Expiry Date: |

Cypher: [1887188137

Date Today: |Thursday, 12 August 2004

Enter Unlock Code... ‘ Re-Lock

Change my Password... ‘

Cancel - Send Feedback

The Options Dialog

Now enter your company name in the Registered To (Company Name) field. Specify it however you want,
but make sure you are accurate, because you cannot change this once the software is unlocked. Your company
name or your name are both good examples.

Once you have entered your Registered To (Company Name) correctly, call CypherBYTE for your unlock
code. During that call, you will be asked for your Registered To (Company Name), and your Cypher. You
will then be asked to click the Enter Unlock Code button, and you then enter the unlock code given to you.
Once successful, click OK and the software is unlocked and fully registered.

An unlock code cannot be used more than once - even on the same computer. This is by design and is to
make piracy more difficult. You do not need to record the unlock code at all - if you need to unlock your
software again you must call CypherBYTE for another unlock code.

Upgrades

CypherBYTE normally maintains its custom designed products on a needs basis - if you need it updated, then
inform us and we can update the software to match any new requirements you may have.

Service agreements can be arranged where, for a set monthly fee, you are entitled to have a level of
modifications or updates made to your software. What level of service you want in such an agreement would
need to be discussed. Contact CypherBYTE if you want to arrange a service level agreement.
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Maintenance and Support

Support and Maintenance of your software is normally covered under the CypherBYTE Maintenance and
Support Agreement. This covers you for things like continuance protection (ensures your software survives
even if we don't), backup of source codes, e-mail and telephone support. If you do not have a maintenance
and support agreement for your software, it is highly recommended that you contact us to organise one. While
not mandatory, it’s pretty risky without it.
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Understanding Users and User Levels

The Admin User

Only the user with the ID of 1 is the real Admin User. This user is the only user who can do everything. If
you lose the password to the Admin User, you will not be able to use it. If you have lost the password to
your Admin User, you will need to call CypherBYTE to have your Admin User password reset. There may be
charges associated with this if you don’t have a CypherBYTE Maintenance and Support Agreement, so make
sure you're covered!

If more than one user is currently logged into the Admin User, and they try to change the password for the
Admin user at the same time, the second user to save gets to choose whose changes are saved. This could
cause some chaos! For this reason it is recommended that only one or two administrators should manage the
Admin User itself, and they should communicate the changing of the password with each other before
changing it.

Most aspects of the Admin user cannot be changed - the user-level must be 10 for instance and the login name
cannot be changed away from “Admin”.

Normal Users
For normal users, the user level and the design of the software determines the level of access to each area.

User Levels

The user level sets the access rights for the user. Your software will have its own unique security configuration.
The following is an example of a user-level matrix showing how level 10 can do everything, level 9 can do
almost everything (except read pay data and change suburb data in the example), and no other user levels can
even log in.

---- User Level -
Element 1] 1 2 3 4 5 6 ¥ [i] 9 10

Main Menu Soreen ' Mo [ Mo
Department Management Soreen Ma Ma
Ermmployes Managernent Screen Mo Mo
Employee Type Management Screen ' Mo ' Mo
Labour Subform Mo Mo
Leave Subform [ Mo i Mo
Leave Type Managerment Screen Mo Mo
Faycode Management Soreen Ma i Ma
Suburb Managernent Screen Mo Mo
Team Management Ma i Ma
Reporting Dialog Box | Mo | Mo

Labour Report g Ma g Ma
Leave Chart Mo Mo
User Listing Report Mo Mo
Userlevel Report Mo Mo

Ability To Create Multiple Labour Entr
Ability To Create Multiple Leave Entri
Can Access Payrate Data
A sample user level report showing how user levels can impact areas of your software
(feature elements may not be identical to your software)
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CypherBYTE Software Features

Understanding Records and Fields

The terms record and field are used throughout this manual. You will need to clearly understand them before
reading on.

« Afield is a data element of a list. In software, Fields are represented as editable boxes.
For example, Surname is a field in a Staff list or Username is a field in the user list.

e Avrecord is a collection of completed fields making up a row in a list (or an entity).
Enter data into the Firstname, Surname, CompanyName, Email and Phone fields to make up a Contact record. Each
person in a contact list is a record.

Navigating the Data

To navigate around the data contained in the current screen, use the navigation buttons at the bottom of the
window. The navigation buttons provide a simple method of moving to the first, previous, next, last or new
records respectively. This is very important to know when you are in a screen that shows you only one record
at a time.

First Record Current Record Last Racord Number of Records

Rb‘}; | !_l‘s FT | >I‘>/*¢in<éd}

Pravious Reacord Next Record New Record Filter Applied Indication
Navigation Button Meaning
First Record Goes to the first record or record number 1. The data in this record may differ

depending upon your current sort order for the screen - it is not necessarily the first
record you entered.

Previous Record Goes to the record prior to the current record.

Current Record Shows you which record number you are looking at. Again, do not associate the
record number with the data you see on the screen. The diagram indicates only that
it is the 3™ record - there is no way to identify which data it is. You can enter a new
number to go to the n'" record in the data.

Next Record Goes to the record after the current one.
Last Record Goes to the final record in the list.
New Record Goes to the record after the last one. This is called the new record. In all screens

where you can add data, you can navigate to this record to start entering data.

Number of Records This shows you how many records you are currently navigating.

Filter Applied If you have completed a find operation, you may not be looking at all records. If the
Indication records have been filtered, the (Filtered) indicator appears.
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Automatic Saving

Before you begin to add records to a database you must understand the way that your software saves data.
Microsoft® Access™ saves records automatically once you exit the record.

Exiting the record can be done in many ways; the following are all valid actions which save the current record’s
changes:

pressing TAB to arrive at the next record

navigating records

closing the screen

quitting the application

selecting the record by clicking the pencil indicator

sorting

filtering

entering sub-forms and objects controlled by code which saves the current record

This is an advantage because it means you don‘t have to remember to save your work. It also means that if
you encounter a power failure you will not have to worry about lost records that you didn't save.

However, this also means that if you accidentally edit or delete a record these changes are automatically saved
and are therefore permanent. It is always a good idea to have a regular and reliable back up of the information
stored on your computer; this is particularly true in the case of databases. Keep your CypherBYTE Data Server
backed up and apply a little care during usage and you can enjoy the automatic saving. There is a feature
which makes saving a lot more deliberate that you can use. See the Editing Records section for details on it.

Entering Data

Entering data is a matter of going to the right data entry screen, navigating to the new record and filling it out
by typing. When you first arrive at the new record, you should be in the first field. To enter data, begin typing
into the first field and press TAB to go to the next field. Type the appropriate information into the next field
and again press TAB. Repeat this until all fields are complete. On the last field, pressing TAB might go to the
first field of the next record.

The Pencil Indicator

Once you have made a change to a record, you will be able to see the pencil indicator ( &) displayed at the left
of the record. This indicator means that the record has not been saved (yet). It changes to I when the
record has been saved.

Whenever you see the pencil indicator it means you can do one of two things; complete the changes to the
record or abandon changes to the record by pressing ESC. This is a vital thing to know - if you were to
accidentally drop your pen (or fingers) on the keys and press a letter, some data (which you may not know
what) would be overtyped. The only way to get the unknown thing back is to press ESC to abandon changes to
the record.

Record Locked Indication

Within a network environment, data is capable of being edited by more than one user at the same time. Your
CypherBYTE software will sometimes display a crossed circle ( @) to indicate that other users have edited and
not yet saved data which is too close to the record you want to edit to be allowed. In this case, all you can do
is wait until the other user saves the record before you can make any changes.

Sometimes your CypherBYTE software will allow such edits but give the person who saves last the option of
keeping the other users’ data or overwriting that user’s changes with their own.
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Editing Records

Once you have added records you may need to make amendments. Making changes is as easy as going to the
screen that defines the data you want to modify and overtyping or editing the entry.

A standard feature in your CypherBYTE software is the requirement to click the Edit button (or press CTRL-E)
before any changes to existing records can be saved. The benefit is that you cannot accidentally overwrite
existing data.

If you don't like having to click 2l , and you are happy to run the risk of accidental overwrites you can

switch this feature off. See the following section on how to do this.

Required To Click Edit

Under normal circumstances you have to click Edit to be able to save changes to an exiting record. After
experience and you are confident enough to do so, you will find it more efficient to not have to do this. Itis
more dangerous, but saves lots of clicks in a day.

You can choose to either click the Edit button to save changes to existing records or not by setting the option:

e Select o Qptions... from the Tools Menu

e Selectthe 3 - Application Settings ltab
e Check or clear the [ Required to click Edit. checkbox to alter the setting
e Click 0K |

The Admin user can also set this in the User Management screen.

Selecting One Record
Click the record selector of the record you want to select.

k| In screens with many records displayed at a time, the record selector is the small grey box at the left of
the records like the two show at the left of this paragraph.

P In screens with only one record visible at a time, the record selector is in the same place, but is as tall as
the screen itself.

Way taller than the one shown at the left!

Once selected, records are ready to be copied or deleted

Selecting Multiple Records

You can only do this to screens which show you many records at a time.
» Shown at the left here are some record selectors.
Selecting multiple records is a matter of dragging through the record selectors you want to select.

Drag from the first record selector of the record you want to select through to the last record selector of
#| the record you want to select.
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Deleting Records
Deleting records is very simple, in most cases. All you need to do is to select the record(s) (the arrow will be
highlighted, “ when selected) and then either;

e Press Delete on your keyboard
OR
e Select PA Delete Record from the Tools menu.

You will be asked if this is REALLY what you want to do:

CypherBYTE Follower 5.0.3

'E You are about to delete 1 record(s).
*
If o click, es, you won't be able to undo this Delete operation.
Are youl sure you wank to delete these recards?

Click Yes to delete the record(s) permanently or click No to delete nothing.

Relational Restrictions

Deleting data is not always possible. If you had a Client record that was using the Suburb record of “Adelaide”,
and then you tried to delete the Suburb record “Adelaide” itself you would get this message:

CypherBY TE Follower 5.0.3

'§ The record cannok be deleted or changed because table 'CLIEMT' includes related records,
L

Help |

Equally, deleting a client when there are financial records referring to that client would also be prevented.

This is a good thing, since deleting these records seems like a bit of a mistake. You would have to be more
deliberate if you really wanted to delete Adelaide -- you could delete all of your clients from Adelaide or assign
all Adelaide based clients a different suburb, then you would be able to delete the Adelaide record from the
Suburbs list.
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Finding Records

As the database grows, you will (at some point) need to navigate the database for a particular record. With a
large number of records, this could take a long time. Specific records or values can be quickly found by
searching the data. Your CypherBYTE software is equipped with customised finding routines. Simply double
click in the field you wish to search.

Find in Field
Enter the PROJECT text wou want ta find:
Canicel

Enter the information you want to find and click OK or press ENTER.

Once you have completed your search, all other data will be filtered out except for data containing what you
typed into the find box. You can tell the filter has been applied because the record navigation buttons at the
bottom of the screen show it ;

ERecord: 4] 4 1k | M k¥ of 1(Fitered)

Notice the (Filtered) indication. This tells you that you have a filter applied - used to search for your data.

Showing All Records

To remove any filters (i.e. see all your records again) simply double click the main heading at the top of the
window (for example the words “"Suburb Management” in the suburb management screen).

You can also select T Remave Filter/Sort from the Tools menu.

Advanced Finding

The simple finding method described above is limited. It can only find data by one single field and its searching
method (contains or starts with for example) is automatically selected for you.

If you need to find data by more than one field or you need a more specific searching method, you will need to
use Queries (described later) or the Filter By Form feature.

Selecting Filker By Form from the I':":'|5 menu, you will see the current screen shown with no data, all buttons
disabled and the title bar will state “filter by form”. When you click in any field it will appear as a combo box.
While in this mode, you define the filter you want to use to define which records you want to see.

To set your filter, click into the appropriate fields and enter your criteria. For example, click in the Surname
field and enter in Like “"*SON" to express that you want to see surnames ending in son such as Bronson or
Wilson. For more details on setting criteria, see the section Example Criteria in the Using Criteria section of
Creating Basic Queries.

Once you have defined the filter you want to use, you apply the filter by using the ~F &pply Filter command from
the Tools menu. Only the records that match your filter will be shown.
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Keyboard Shortcuts

Some people prefer to use keyboard shortcuts instead of using a mouse. (Depending on your level of typing
skills this may or may not be quicker). All the menus, buttons and tab controls in your CypherBYTE software
have keyboard shortcuts. To use the keyboard shortcuts hold down ALT and press the letter (or number) that is

underlined.

[

kil |ALT-D is the same as clicking Done and ALT-N is the same as clicking New.

There are also a range of keystrokes available for moving around your data.

Keystrokes In Screens With 1 Record In Screens With > 1 Record

TAB Move to next field Move to next field

Shift-TAB Move to previous field Move to previous field

PGDN Move to next record Scroll one visible screen down

PGUP Move to previous record Scroll one visible screen up

HOME Move to first field of the current record [Move to first field of the current record
END Move to last field of the current record Move to last field of the current record
CTRL-HOME Move to first field of the first record Move to first field of the first record
CTRL-END Move to last field of the last record Move to last field of the last record
CTRL-UP Move to current field of the first record [Move to current field of the first record
CTRL-DOWN Move to current field of the last record Move to current field of the last record
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User Management

Managing Usernames and Passwords

You can edit the list of users and passwords through the User Management screen. You can get to this by
clicking the User Management button from the main menu. Only users with a user level of 10 will be able to
make changes in the user management screen and no-one can change the Admin user.

Eile Edit Tools
0544 P User Management

T e ; g ser Leve Status  Edit

All records displayed.

User Level Report
From here, you can manage all users (except the Admin user cannot be changed by anyone other than the admin user).

Resetting User Passwords

There is no confirmation on changing the password in the password box (except for the Admin user). If you
type it wrong, or you need to reset it, you can just change it again.

If you cannot log in to change your password, you will need to log in with the Admin username to do it or ask
the person who controls the Admin user. If you have lost your Admin password, you will need to contact us at
CypherBYTE to have it reset.

Managing Access Rights

You can modify User Levels to provide the access you want to give. Examine your User Level Report to see
which user levels give what kind of access to where. You can find this report in either the Reporting area or
the User Management screen itself.

Status of Users

All users are “Normal” by default. When a user leaves your environment, it may or may not be possible to
delete the user. For example, if your software binds transactions to users, then deleting the user may result in
a relational restriction (described previously). In this case what you should do is set the user to Inactive.
Inactive users cannot log in.

Overriding Edit

As mentioned previously, you can set users’ override settings here. A tick in the Edit Override box means that
user does not see or need to use the Edit buttons as described in “Editing Records” previously.

Sending Us Feedback

You can send an e-mail to us at any time regarding your CypherBYTE software. Let us know what you think,
report bugs or request upgrades.

e Select ®w Qptions.., from the Tools Menu

The send Feedback button allows you to send e-mail to CypherBYTE.

You can also simply direct your e-mail to us at CypherBYTE (solutions@cypherbyte.com.au)
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Creating Basic Queries

This section of the manual describes some basics about creating customised queries using your CypherBYTE
Data Server as the source of information. You might choose to do this in order to, say, create a query of your
client or supplier list in order to perform a Mail-Merge with Microsoft® Word™ or maybe export the information
to Microsoft® Excel™ to create a chart or analyse the data extensively.

The following describes the methodology for creating simple select type queries. For more information
regarding learning more about creating your own queries and reports, contact us at CypherBYTE for some
training.

Firstly you will need to have design access to either your CypherBYTE Data Server file itself, or a Microsoft®
Access™ database with links back to your CypherBYTE Data Server in order to create any queries.

READ ALL OF THE FOLLOWING WARNINGS BEFORE ATTEMPTING TO CREATE YOUR OWN QUERIES

Warning: Providing access to your CypherBYTE Data Server could be dangerous. Changing data within your
CypherBYTE Data Server could have severe and detrimental effects on your custom CypherBYTE software.

Warning: Modifying the data which is displayed as a result of a query you created will in fact modify the
original data back in the tables of the CypherBYTE Data Server.

Warning: Any query you find which has an exclamation point (!) near it's icon indicates that is an action query.
If you try to open an action query the same way as opening one of your own custom select queries, you will be
modifying data back in the tables of the CypherBYTE Data Server.

Warning: Do not make any unauthorised changes to the CypherBYTE Data Server’s table structure. Such
changes may render your customer CypherBYTE software unusable.

Once you have design access to the database you want to create tables in;
e Click on the Queries tab.

e To create your new (empty) query, click the New button, then click Design View, then OK.
e Select the table(s) you want to include in your query and Add them. Click Close when done.
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Query Design

In a query you define which fields you want from which tables. You can then sort that data or filter the records
to show only those which match your criteria.

The
Tables
to be
Queried

How
to
Query

gz Queryl : Select Query

IS[=] E3

Field:
Table:
Sort;
Shay:
Criteria:
on;

|

The top half of the window shows the table(s) you want to include, while the bottom half gives an area to
define how you want the results sorted, and any criteria that you want to apply.

Adding a Field

To add a field to the design grid, simply double click it within the table in the top half of the query window. The

field will be added to the right of the right-most field added.

You can also type the name of a field into the field row of a blank column.

Removing a Field

To remove a field from the design grid, either delete the entire column or empty the field row for that column.
Both are equally as effective after saving.
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Using Criteria

You can specify criteria for the fields you want to filter. You might be looking at a list of customers and
suburbs. You can specify the criteria “Adelaide” in the suburb field and you will only get to see clients from
Adelaide when you view the results.

Data types

There are several data types which can be used when specifying criteria. The most common of these is text.
The data types each have specific delimiters, which are characters that are placed either side of the criteria.

Type Delimiter | Example
Literal Text i “Fred”

Date Data ## #01/05/99#
Field References [] [CD Code No]

Criteria Expressions

You specify criteria in the criteria row of the design view in the field from which you wish to obtain specific
information. The example below will limit the results to show only those Customers with a CustomerID field
which is exactly “Smith”.

Field: | CustomerlD
Table: | thiCustomers
Sort;

o i
| Criteria: [Smid] |

T
4 |

OR Criteria

If you need to select records where the field value may be one of a number of possibilities, define the criteria
with a list all of the values you want to see separated with the word OR.

Examples:

“Smith” or “Smythe”
“Adelaide” or “"North Adelaide”

AND Criteria

If you want to select records only if all of a set of conditions are met (eg. LastName = Smith and OrderDate
= 15/5/97), place the values on the same row(across). The query will only select the record if all of the
conditions on that row are met:

Field: | CustormenD OrderD ate
Table: | tbICustamers thi0rders
Sort;
S b
Criteria: | "'Smith" B15/05/974
ar;
4 |

This query would show records where both conditions are met — The CustomerID must be "Smith”
AND the OrderDate must be the 15 of May, 1997.

If you placed the criteria on different rows, it becomes an OR. For example, put the date criteria one row
further down and it means Surname = “"Smith” OR OrderDate = 15" of May, 1997.
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Examples of Criteria

The following Table gives some examples of the different criteria you can enter. This should get you started in
creating your own expressions:

Criteria Displays Extracts
Adelaide “Adelaide” Field must equal ADELAIDE.
Not Adelaide Not “Adelaide” Field must not contain ADELAIDE

Not Adelaide AND
Not Melbourne

Not “Adelaide” And Not
“Melbourne”

Field can contain any value other than ADELAIDE
or MELBOURNE.

*son Like “*son” Field must end in the three letters SON.

Smith* Like “Smith*” Field must start with SMITH.

*PEN* Like “*PEN*" Field must contain PEN anywhere.

*son and t* Like “*son” And Like “t*” | Field must start with T and end in SON... such as
Tyson.

A* and B* Like “"A*” And Like “B*" Illogical request, nothing can both start with A and
also start with B. To list people with surnames
starting with A or B, the OR operator should be
used, not the AND operator.

>500 >500 Field must have a value over 500

<500 <500 Field must have a value under 500

>=500 >=500 Field must be greater than or equal to 500

<=500 <=500 Field must have a value less than or equal to 500

>=10 and <=50

>=10 And <=50

Field must contain a value that is between 10 and
50 inclusively.

>=50 or <= 65

>=50 Or <=65

Think of a number between negative infinity and
positive infinity. Is it greater than 50 or less than
65? This common error returns all values and is
an example of where AND should be used instead
of OR.

Between 10 and 50

Between 10 And 50

Same result as the previous entry. Field must
contain a value between 10 and 50 inclusively.

Between started

Between “Started” And

Field must contain text which is alphabetically after

and finished “Finished” or equal to STARTED and less than or before
FINISHED. A bit like saying between A and D.
>12/11/06 >#12/11/2006# Field must contain dates after the 12" of

November 2006. Or is it the American version 11
of December? You have to be cautious with this as
your Control Panel in Windows determines it and
since both Windows and MS Access are made in
the USA... I always use 12 Nov 2006 rather than
12/11 because of the possibility of error here.

Between 6 July
2006 and 15 July
2006

Between #6 July 2006#
And #15 July 2006#

All records with a date between the 6th of July
2006 and 15th of July 2006.

Note that criteria are NOT case sensitive.
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Sorting Data

Information presented in a Query can be sorted. The third row of the desgn grid is the Sort: row. Click in the
Sort: row of the field to sort by, and select either Ascending or Descending sort order from the drop-down list.

You can sort data across several columns, with the left-most column sorted taking precedence. If you wanted
to sort by Surname then by Firstname, the Surname field must be more left in the grid than Firstname.

Creating Calculated Fields

You can create simple calculative fields based upon formulas within a query. You define your expression by
entering your calculated field into the field row of a new column in the following format;

NewFieldName : Expression

Example Calculated Field Would provide a new...

GST : [Subtotal] * 0.1 GST field which is 10% of the field Called Subtotal.

SubtotallncludingGST : [Subtotal] * 1.1 | SubtotallncludingGST field which was 110% of the field Called
Subtotal

Expression Rules

You have to use the typical computer lingo for math signs for addition, subtraction, multiplication and division
(+ - * / respectively). And of course, BODMAS still applies (or whatever name they gave it when you were at
school!). It is the thing that means you need brackets to make sure a math operation is done in the right way.

To explain this BODMAS a little, 24+2*2 does NOT equal 8. It equals 6. You see, multiplication (the M in
BODMAS) comes before addition (the A in BODMAS), so 2*2 is processed to four before 2 is added.

BODMAS stands for Brackets, powers Of, Division, Multiplication, Addition and Subtraction and it represents
the order of processing for complex mathematic formulas; brackets first, then powers, then division etc.

Example: Cost + GST gives sale price. To divide the sale price by 2 you might try Cost + GST / 2. This only
halves the GST amount because the division is done first. Correct according to BODMAS is (Cost + GST) / 2.

More Queries and Reports

If you would like to learn more about designing queries and reports for your Microsoft® Access™ data, please
don’t hesitate to contact us here at CypherBYTE to discuss your training needs.
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